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What is the Liquid Brand Design and
why do we have it?
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Our Challenges: Many Target Groups & One Brand

* We serve different target groups across valantic

* Target groups cannot be assigned to competence centers or divisions - there are overlaps

* Each division has common touchpoints with other divisions

* But still each division has its own area of activity and unique selling points

* Our growth, new technologies, business areas and user needs pose new challenges for the brand identity
* Efficient rebranding projects of new CC are problematic due to lack of clear design guidelines

* Job applicants and customers alike are irritated by many different designs on our external channels (web, social, ads)

o
ONE FIRM | ONE BRAND | ONE DESIGN

o
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The Solution: Liquid Brand Design
Liquid Brand Design
Design flexibly for specific target groups with distinct
orand recognition through consistent visuals.

valantic ‘ ‘

LOGO Color Gradient '
(Coral — Peach) valantic Shape
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WHAT IS THE LIQUID BRAND DESIGN AND WHY DO WE HAVE IT?

Tailored flexibility for specific audiences: Three design approaches enable
distinct visual communication for various target groups and contexts.

- Route A
restrained | elegant | informative
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Touchpoints
depending on the

target group — Route B

self-confident | activating | human

Route C
dynamic | present | expressive
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WHAT IS THE LIQUID BRAND DESIGN AND WHY DO WE HAVE IT?

Moodboards: That's what they look like

Route A: restrained | elegant | informative Route B: self-confident | activating | human Route C: dynamic | present | expressive

[ - L l

valantic valantic : ‘—" valantic l
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ELEMENTS Of ELEMENTS OF THE ! ;Lr__ﬁl
DIGITAL NOW DIGITAL NOW T coummnvemmsenmaion
Company presentation (NSNS A ND BEEN- SN @400 B G =¥ o mmmoanon Elements of the
digital now

Companies are on the path to the digital transformatic Companies are on the path to the digital transformation

Smart Industries

Conception, implementation and operation of digital
end-2-end business processes and services

Companies are on the path to the digital transformation
Smart Industries ; O /O 8 ; A)
o

Conception, implementation and operation of
digita end 2-end

|- O

21%  44%

Smart Industries

believe:

valantic valantic
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WHAT IS THE LIQUID BRAND DESIGN AND WHY DO WE HAVE IT?

The choice of the appropriate route depends on the target group, the

touchpoint and the message

Route A

restrained | elegant | informativ
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Route B
self-confident | activating | human

Route C
dynamic | present | expressive

Expressivitat

valantic

For example:

Conservative industries, such as insurance and banking
High-probity services, such as finance, legal and data privacy
Informative customer communication, such as invoices and data
sheets

For example:

Internal Communication

Agile customers and sectors, such as IT, manufacturing and
automotive

Services involving entire teams, such as development and
product implementation teams

Internal communications

For example:

Recruiting events and fairs in which we want to stand-out
Addressing Marketing people and start-up customers
Zeitgeist-sensitive industries, such as tourism and consumer
goods

Agency-related services, such as e-commerce and design

valantic PowerPoint Manual



Which route is the appropriate one?

Ask yourself: These considerations should not play a role in the
* Who do you want to address, who is your target group? choice of route:

* How do you want to be perceived? * Which route do | personally like best?

* In what context do you want to present? * These designs are finally something different | could use

* Should the presentation only be sent by e-mail? ° I don't like orange/blue/purple

valantic
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WHAT IS THE LIQUID BRAND DESIGN AND WHY DO WE HAVE IT?

No idea which route to choose? Then route B is always a good choice

Route B
self-confident | activating | human

Fits for

- 80%

valantic brand design and is always a of all cases.
suitable choice in case of doubt.

Route B is a modernized version of the previous

o
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Installing the PowerPoint Templates
On Windows
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3 Steps to install the templates

1. Saving the Designs (.thmx)
2. Storing the file "Layout Samples” (.pptx)
3. Storing the valantic diagram templates (.crtx)

valantic



1. Saving the Designs (.thmx)

* Save all three masters (Route A, B, C) - this way you will always have all the routes at your fingertips.

* Open the respective Layout Samples file

* Then go to Save As

* First select the file format Office Design (*.thmx)

* In many cases the path will already be set

* If the path is not set automatically, select the destination folder manually.

* The saving path is C:\Users\[yourusername]\AppData\Roaming\Microsoft\Templates\Document Themes
* Give the file a name of your choice (e.g., "Route B valantic Design <date>") and save the master there.

* The master is now saved, and you can create new blank PowerPoint presentations based on the installed master.

* Don't forget to repeat this step for all the routes A,B and C

If you cannot see the following path in PowerPoint: C:\Users\[yourusername]\AppData, then pl
slides 18 ff “Show Hidden Folders” and try to save the file ¢

o
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ﬂ A_Layout-Samples_20230829 - Read-Only » Saved to this PC

©
@ Home
D New

[~ Open

Info
Save
Save As
Print
Share
Export

Close

Account
Feedback

Options

Save As

@ Recent

valantic GmbH

. OneDrive - valantic GmbH

Alisha.Attarwala@muc.valantic.com

Sites - valantic GmbH
Alisha.Attarwala@muc.valantic.com

Other locations

‘ &I This PC

@ Add a Place
B Browse

Alisha Attarwala & for ? -

1\ [~ C > Users > AlishaAttarwala > AppData > Roaming > Microsoft > Templates > Document Themes

| A_Layout-Samples_20230829

W

|' Office Theme (*.thmx)

v| | [ save |

PowerPoint Presentation (*.pptx)

PowerPoint Macro-Enabled Presentation (*.pptm)
PowerPoint 97-2003 Presentation (*.ppt)

PDF (*.pdf)

XPS Document (*xps)

PowerPoint Template (*potx)

PowerPoint Macro-Enabled Template (*.potm)
PowerPoint 97-2003 Template (*.pot)

Office Theme (*.thmx)

PowerPoint Show (*.ppsx)

PowerPoint Macro-Enabled Show (*.ppsm)
PowerPoint 97-2003 Show (*.pps)

PowerPoint Add-in (*.ppam)

PowerPoint 97-2003 Add-in (*.ppa)
PowerPoint XML Presentation (*xml)

MPEG-4 Video (*mp4)

Windows Media Video (*wmv)

Animated GIF Format (*.gif)

JPEG File Interchange Format (*jpg)

PNG Portable Network Graphics Format (*.png)
TIFF Tag Image File Format (*.tif)

Device Independent Bitmap (*bmp)

Windows Metafile (*wmf)

Enhanced Windows Metafile (*.emf)

Scalable Vector Graphics Format (*.svg)
Outline/RTF (*.rtf)

PowerPoint Picture Presentation (*.pptx)

(=1}

(=1}

[*3)
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2. Storing the file “Layout Samples” (.pptx)

* The three files A_Layout-Samples, B_Layout-Samples, C_Layout-Samples are
your layout samples which help you to interpret the integrated layouts

* In the respective file Layout Samples, each integrated design is used once File Home Insert Draw Design Tr
* You can drag individual slides into the file you are working in using the
"Reuse Slide" function. You then only have to enter your texts. This can r—h
simplify your work _|:| -
Paste
- Therefore, save the three files A_Layout-Samples, B_Layout-Samples, v >
C_Layout-Samples in a place you can easily access at any time! Clipboard N

o
Valantlc valantic PowerPoint Manual



3. Storing the valantic diagram templates (.crtx)

Step 1 Charts X + B =
Charts
o New X 18] [© () = \mj R Sort = View ¥ ee
&« v > ThisPC > OS(C) » Users > AlishaAttarwala > AppData > Roaming > Microsoft > Templates > Charts v (@] Search Charts ,
* Open your file explorer and find the following .
ﬁ Name Date modified Type Size
folder: C\U SerS\[yOU ruserna me]\AppData\ =] ] 001_valantic-column-6cm 04/09/2023 17:57 Microsoft Office C... 7Ke
H H 002 valantic-pie-chart-6: 04/09/2023 17:57 Microsoft Office C. 9K
Roaming\Microsoft\Templates\Charts B (002 el e chart &m S e
-] 003_valantic-dougnut-chart-6cm 04/09/2023 17:57 Microsoft Office C... 9KB
° Copy all the .crtx files in the Charts folder. 1] 004 valantic-column-9cm 04/09/2023 17:57 Microsoft Office C 7KB
4] 005_valantic-stacked-column-9cm 04/09/2023 17:57 Microsoft Office C 7KB
] 006_valantic-column-100-percent-9cm ~ 04/09/2023 17:57 Microsoft Office C 7KB
<] 007 _valantic-column-T4cm 04/09/2023 17:57 Microsoft Office C 7KB
] <] 008 _valantic-column-22cm 04/09/2023 17:57 Microsoft Office C 7KB
[ <] 009_valantic-combi-2axes-30cm 04/09/2023 17:57 Microsoft Office C 8KB

o
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INSTALLING THE POWERPOINT TEMPLATES ON WINDOWS

3. Storing the valantic diagram templates (.crtx)

Insert Chart ? X

Step 2 Al Charts

cen My Templates
E Templates 1_valantic-column-6cm 002_valantic-pie-chart-6cm
* Now you can use charts in the valantic design b# Line
@® rie
* Insert a chart and select the appropriate type E o
under Templates 22 xvescaten | |
@ Map 003_valantic-dougnut-chart-6cm 004_valantic-calumn-9cm
* By default, the charts are dark blue, but you can P
change the color via "Change color". % Radar LEPe 2 @212 @ 2 ome -~ %
Treemap Element ~ Layout [Colors ¢ 3 Dat:
Monochrome or multicolored @ sunburst o i
hﬂ: Histogram e
§%  Box & Whisker 005_valantic-stacked-column-9cm 006_valantic-column-100-percent-9cm Click to add title
M Waterfal =
? :unﬂe l . 2 lonocl atic
i n Q
HEEN

Combo I I - .

Manage Templates.. Cancel

valantic

o
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Show hidden folders

Please note — you only need to execute this step if you cannot see the followi

G A_Layout-Samples_20230829 - Read-Only + Saved to this PC Alisha Attarwala & Aj ? - o X
@ Save As
ﬁh Home . . .
@ R " [ C > Users > AlishaAttarwala > AppData > Roaming > Microsoft > Templates > Document Themes
ecen
™ New | A_Layout-Samples_20230829 |

AppData is a so-called hidden folder. Maybe you can't see it in your explorer? This is how you can make it visible:

* Start File Explorer and navigate to the folder C:\User\[Your_User_Name]

* Go to the View tab in the top bar or Display in Windows 11

* Check the Hidden items setting or for Windows 11 first go to Show and then check the Hidden items setting
* Now you should see some folders and files that were previously hidden - including AppData

* Follow the description Installing a PowerPoint Master on Windows to install the master

- If you still don't see the AppData folder or have any other problems installing the master, talk to your IT.

valantic
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Windows 10

Freigeben Ansicht

B Extra groBe Symbole B GroBe Symbole

BE Liste

B Inhalt

Vorschaufenster
Kleine Symbole

Detailbereich H Kacheln

Layout

Dieser PC 05 (C:) Benutzer

BE mittelgroBe Symbaole
B-- Details

. (W] Gruppieren nach -

I Spalten hinzuflgen
Sortieren i ~
nach ~ GroBe aller Spalten anpasser

Aktuelle Ansicht

v| Elementkontrollkdstchen

Dateinamenerweiterungen
Au [te Optionen

Ausgeblendete Elemente _ rlemente ausblenden -

Ein-fausblenden

valantic
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INSTALLING THE POWERPOINT TEMPLATES ON WINDOWS

Show hidden folders on Windows 11

AlishaAttarwala * +

@ New ~ T sort ~

Extra large icons

&« > v A » ThisPC » OS({C:) » Users » Alishaltt = v C
O Large icons
4 MName Dlate modifie :
- 2 Medium-sized icons
4 () 2D Objects
55 Small icons
| AppData
List
Contacts
+ = Details
Bl Desktop 04/05/2023 1¢
8= Tiles

= Documents

8= Content

d
T

4 Downloads

= Compa

Favourites 03/07/2023 1C

]

Links 03/07/2023N Navigation pane

2 ¢

@ Music File folder (B Details pane
. @ OneDrive 29/08/2022 16:56 File falder (D Preview pane
-
& OneDrive - valantic GmbH 04/09/2023 18:46 File folder oo P
i _ . X Show or hide the files and folders that are marke:
P4 Pictures 03/07/2023 15:25 File falder hidd
e d

Saved Games File folder z "
~ /G Hidden items
Searches File folder
[ valantic GmbH 31/08/2023 13:44 File folder
& Videos 03/07/2023 10:23 File falder
L : |
NTUSER 30/08/2023 09:04 DAT 17,920 KB
>
»
17 items

o
VCIIOntIC valantic PowerPoint Manual 20



Save the templates to reuse it - pin it under favorites

* Open PowerPoint

* Create a new file via New

* Now select Custom in the lower area and then Document Themes
* Select our Master

* An empty file opens with all layouts of the routes A, B and C

* Have fun editing it

- If you click on the pin next to the thumbnail, the template will be displayed directly in the upper area.

o
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G Presentation18 - PowerPoint

@ New

{n) Home
S
R Aa Aa Aa
= Open
Info ) C_Layout- B_Layout- A_Layout-
Blank Presentation Samples_20230829 Samples_20230829 Samples_20230829
Save
Save As Office ~ Custom
Print
Share
Export
Close R
Custom Office Document Themes

Templates

valantic PowerPoint Manual 22



G Presentation18 - PowerPoint

©

frh Home
| D New

= Open

Info
Save
Save As
Print
Share
Export

Close

valantic

New

€~ Back Document Themes

Opening next time

ale) i~

A_Layout- B_Layout- ﬁ
Samples_20230829 Samples_20230629

A 4

C_Layout-
Samples_20230829

3

valantic PowerPoint Manual
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When you reopen PowerPoint, you will be able to see the pinned templates

& Presentation18 - PowerPoint

@ New

o) Aa Aa

[ T [ [ T [
A_Layout- B_Layout- C_Layout-

Info ;

Blank Presentation Samples_20230829 Samples_20230829 Samples_20230829 i
Save
. Office  Custom
Print
Share
Export
Close

Custom Office Document Themes

Templates

o
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Installing the PowerPoint Templates
On MacOS

valantic




Step by Step on a Mac

1. Save the Templates (.potx)
2. Save the Designs (.thmx)
3. Install the Chart Designs (.crtx)

- Tip: All 3 steps can be done at the same time. Here the target folder User Content
with the individual subfolders is important for the installation (then follow each step

from point 3).

valantic



1. Save the Templates (.potx)

. Go to Library on your Mac
On Finder -> Go, press key OPTION -> choose Library
Go to the folder: Group Containers -> UBF8T346G9.0ffice -> User Content -> Templates

R

Insert the files to the folder:
valantic_A_Route.potx
valantic_B_Route.potx
valantic_C_Route.potx
valantic_ABC_Route.potx

5. Restart Power Point.

6. Part 1 is ready.

o
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2. Save the Designs (.thmx)

. Go to Library on your Mac
On Finder -> Go, press key OPTION -> choose Library
Go to the folder: Group Containers -> UBF8T346G9.0ffice -> User Content -> Designs

R

Insert the files to the folder:
valantic Route A.thmx
valantic Route B.thmx
valantic Route C.thmx
valantic Route ABC.thmx

5. Restart Power Point.

6. Ready with the second part!

valantic
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3. Save the Chart templates (.crtx)

. Go to Library on your Mac
On Finder -> Go, press key OPTION -> choose Library
Go to the folder: Group Containers -> UBF8T346G9.0ffice -> User Content -> Chart templates

R

Insert the files to the folder:

001 _valantic-column-6cm.crtx

002_valantic-pie-chart-6cm.crtx
003_valantic-dougnut-chart-6cm.crt

004 _valantic-column-9cm.crtx
005_valantic-stacked-column-9cm.crtx
006_valantic-column-100-percent-9cm.crtx

007 _valantic-column-14cm.crtx, 008 valantic-column-22cm.crtx
009 _valantic-combi-2axes-30cm.crtx

5. Restart Power Point.

6. Ready with the third part!

- The Installation is finished.

valantic
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INSTALLING THE POWERPOINT TEMPLATES ON MACOS

Saving files on Desktop

Office theme THMX

\Users\Name\Library\Group Containers
\UBF8T346G9.0ffice\User Content\
Designs (engl. Themes)

Charts

\Users\Name\Library\Group Containers
\UBF8T346G9.0ffice\User Content\
Diagrammvorlagen (engl. Chart templates)

valantic

= User Content

[S—

. UBF8T346G9.0ffice

e

Group Containers

=" Library
YOUR USER NAME
59 Users

——

E Macintosh HD
B MacBook Pro

———
= .ﬂ_.

POTX

\Users\Name\Library\Group Containers
\UBF8T346G9.0ffice\User Content\
Vorlagen (engl. templates)

valantic PowerPoint Manual
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Segoe Ul Biz2a A AN | L

<
Il
<
%
<
|

s (I11

Font Collections

E==||}+@~
Segoe Ul Light i
Download SegoeUl e
Segoe Ul (Body)
+~  Segoe Ul > Segoe Ul
The fonts on the Mac can be loaded via t ADLaM Display v Light
: Dok e & Light italic
Use cloud fonts to make sure your slides and documents look the same, no matter where you open them e g v
. : . : : ¢>Semilight
or who else views them. Cloud fonts are fonts hosted in the cloud by Microsoft 365, and are available in the Dpanisans . {Jf}semu'{u'gmE ;-
. . . . |2 Semilight Italic
latest versions of Office applications. Gilroy
: : : : . . Ubunt ,
Once downloaded, the font is available for use in all Office apps. Cloud fonts are available to Microsoft 365 c ubn lu : ¢ ltalic
orpe i
subscribers — you too. o ] ¢>Semibold
<[> Semibold Italic
Instructions: G000 BRUSY {>Bold
: : £ Bold Italic
1. To get the cloud fonts, your device needs to be online and connected to the Internet. ¥
Aaargh € Black
2. Open a new file from "New from Template": valantic_A_Route €[> Abadi > & Black italic
Abadi MT >
3. Go to the tap Home -> go to the menue of the fonts on Segoe Ul and click then on the Cloud - ;m
Academy Engraved LET |
icon on following fonts: Segoe Ul Light, Segoe Ul Regular, Segoe Ul SemiBold. The font will be ADLaM Display
downloaded. Adobe Arabic
Notes: & hgency FA >
’ Agentur
* Inapps running on Windows, go to File > Account, select Manage Settings under Account Privacy, Aharoni
and turn on Optional connected experiences. Clearing the check box turns off cloud fonts and other ——
online services from Microsoft. Gl i >
Al Nile >
* If you can't access cloud fonts, make sure https://fs.microsoft.com hasn't been blocked by your IT admin. Al Tarikh
> Aldhabi
b
vqlantic Alegreya Sans

. >
valantic PowerPoint Manual
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Before you start ...

Some basic info

valantic




BEFORE YOU START..

How to use the templates

Use

Imagery

- Please use only one route for a - Use integrated layouts - this - Please use the provided image files.
presentation. simplifies the transfer of slides to If you choose your own images,
- Mixing slides from different routes is different routes immensely — please follow the instructions for the
not intended in the valantic design. especially, if you have to merge your valantic image world and the
content for joint presentations with respective routes. You can find them
other valantic CCs. in the imagery files and in the Web-

Styleguide. (PW: valanticWarmRed)

o
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BEFORE YOU START..

We can use the icon set from Microsoft (stock icons)

& AutoSave IL;' '_1_' ]}[ |Z| o= Presentation20 - PowerPoi

File Home Insert Draw Design  Transitions  Animations  Slide Sho

R B M & E DY

Mew Reuse Table Pictures Screenshot  Photo Cameo | Shapes lcons
Slide ~  Slides - Alburn ~
Slides Tables Images Camera

- ,Insert”

- ,lcons”

valantic

>
StOCl( Images © @ Graphics Format
= EN OGO DLE | £ shapeFill~ | 9 Find
. ! ALTL L5 prange Quick | Theme Colors -
Images lcons Cutout People Stickers Videos lllustrations Cartoon People » EON IR T v sy N OEEEE EEa

i iing
cloud X | IIIIIIIIII

‘Custom Colors

0 (T mum
N
.3 Standard Colors
[ ] | EEEEN

N Fill

More Fill Colors..
S
&R RS a® o
(i

[ Gradient >

* 5 KO XK G =

- Search in the language in which the system is - Select
installed.

- Paste

o |
- We only use the thin icons! - Change the color

Cancel

valantic PowerPoint Manual
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BEFORE YOU START..

Integrated Layouts: Easily customize slides across routes

* The special thing about the new master is that (almost) every layout is available in every route

* If you consistently use these layouts, slides from one route can be transferred to another route very quickly - the layouts are numbered for this purpose

- "A 012 : colored rows icons : picture right" corresponds to "B 012 : colored rows icons : picture right" and "C 012 : colored rows icons : picture right".

- If no layout fits, assign one of the basic layouts work within the guidance lines. If you exactly use the slide layout, then you can easily transfer the slide to another

route’s layout within seconds.

valantic

ROUTE A

Integrated Layouts
Overview

Route A

—

Line A | guidance: | A 001:BASIC title | Line A | guidance: A 002:2contents A 003:3 contents
cover and content basics

Integrated Layouts
Overview

Route B

Line B | guidance : | B 001: BASIC title | Line B | guidance: B 002:2 contents B 003:3 contents
cover and content basics

A 014: content: 2
i :

Tcontent: A O12:4colored A 013: content: 2
Tlem  rowslcons: pict..  pi

|l

A 022:reference A 023:content  Line A | guidance : A 0243
cases: picture left left: picture righ...  text & graphics  icon-circles: 3 c...

A 035:8texts: 8
subtexts table

A 010: content: A 01
Tem

A 025: 4text
boxes : Icons

Line A | guidance: A 036: full page
nutshells & pict... picture: bluetext...

A034:15
logowall

A 033:8 logowall

B 010: content :
picture right 17em

B 014: content: 2
pictures right : ¢

B O11:content: B 012:4 colored
picture right 11cm  rows lcons : pict.

B 025:4text
boxes : lcons

8 036: full page
picture : 1 gradie...

B 024:3
icon-circles: 3 c..

B 023:content Line B | guidance
left: picturerigh...  text & graphics

B 035:0texts: 9 Line B | guidance:
subtexts table nutshells & pict...

B 022: reference
cases : picture |eft

B 033:8logowall B 034:15

logowall

Integrated L
Route C

Route C

ND CON

Line C |only C 001: BASIC title
qui € t

TENT

ayouts

N

Line C | guidance:

C 002: 2 contents

C 003: 3 contents

C 013: content:2

C 014: cont C 015: 2 contents

"C 010: content € OT1: content

C 022 reference
cases: pictureleft left: picture sigh..

C 012: 4 colored
picture right 17cm  picture right 11cm  rows lcons @ pict...

C 023: content  Line C | guidance:
text 8 graphics

pictures right

pictures right: c...  : picture right

TEUE S

C 024:3
Icon-circles: 3 c...

“Codits

C 035 texts: 9

C032:map:8 C 033:8 logowall
contents

logowall

subtext table

C 026: dtext
boxes  stripes : I...

C 025: 4 text
boxes : Icons

Line C | guidance :
nutshells & pict...

C 036: full page
picture : gradien...
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Use the Layout Samples via “Reuse Slides”

* Use the "Reuse Slides" function to load ready-made designs from

the Layout Samples file into your file. Then you only have to adjust '&D —Nﬂ lﬁ Layout ¥
the contents basto New Reus; 3 Reset
~ Slide v Slides {5 Section v

* Load only slides from Layout Samples A into a presentation based

. . Cliphoard M~ Slides
on Route A, and so on. The samples for A, B and C are identical

- So save the three files A_Layout-Samples, B_Layout-Samples,
C_Layout-Samples in a place you can easily access at any time!

- Don’t forget to also save the Company Presentation, References
and Imagery files.

valantic

File Home Insert Draw Design Tr

Reuse Slides v X

< | Search OneDrive, SharePoint and this PC

o
>

@ C_layout-Samples_20230829

nsert All
Use source formatting

Slide 1

nsert Slide

Slide 2

nsert Slide
Slide 3
v
valantic
i m=1 oo EEl S e e e
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Use the image library and insert images

Add images to your slides

In the imagery files we have put together suitable imagery worlds for the routes

A, BandC. \
o - - - - e Cm— e
This is how you insert images into your files: . © LS et (20 A g
lick to add text Font [ Copy [
. n . M . . - lick icon to add picture o Click icon to add picture [B Paste Options:
* Use the function "Reuse Slide" and open the appropriate imagery file. i Y
Edit Text
* Paste the slide with the image of your choice into your work file
* Now use "Copy" to get the image from the slide into your clipboard valantic images to your slide ¢, .. s ,
I -
* Go to the slide you want to paste the image into \
] Reuse Slides v}
¢ Click on the image placeholder that you want to fill in order to activate it. | =
. . . icktoaddtext | B3 View Alt Text. -
* Paste the image into your image placeholder ‘ Rickicon o s pere 1] e ard o, I :
% Format Shape.
. . . . 17 New Comment
* You can now delete the slide with the large image from your presentation. 7 - =
Add images to your slides @v 2” - 'Lr,'j l?ju
Syle  Fil Outline CU:‘;"ZN tsEBZ:kA
6 5

valantic

o
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A special characteristic: Segoe Ul Bold vs.

* Unfortunately, our font Segoe Ul does not have nice proportions under
Windows when it is used in the "Bold" version.

* If you are a design hero, you format your text sections using the Segoe Ul
Semibold font. You do this directly above the "Bold" button - it's just one
click more.

—This is what Segoe Ul looks like in bold.
—This is how Segoe Ul Semibold looks like.

valantic

Segoe Ul Semibold

|Segoe Ul Semibold (Heading ~|[24  ~|

B |[I U S a AV~ Aa-~

T Font

Segoe Ul Semibold ~|(24

AN A A

Theme Fonts

Segoe Ul Semibold
sSegoe L

i

(Headings) I

(Body)
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BEFORE YOU START..

Styleguide for PowerPoint

— At the end of the Layout Samples file (.pptx files) for routes A, B and C you will find a small style guide with do's & don'ts for each route.

4 stylequide

i o b M e e s 41 b e, B
i . ety Eapt

e

T

’ i s Sege Uit Meading Segoe UL feading Segoe Sem : =

70 T 72 73 74

B X @ wW ' @ w @ =
= o B Y O® T R Om @ £ -
B O M 6 @ @ m om B & =
= GRS i B = @ [=] & o il .....
- = e « L I S = R = | i
75 76 i 78 79
== e .
T
f—— :_;_
T ([ i
= = oon EEEEE
80 81 82 83

o
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PowerPoint Tips & Tricks
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POWERPOINT TIPS & TRICKS

Using list elements for quick formatting

This is an example of regular text. It can be formatted quickly and easily using
the function Increase List Level.

* Increase List Level clicked 1 x : Level 1 bullet
— Increase List Level clicked 2 x : Level 2 bullet

— Increase List Level clicked 3 x : Level 3 bullet

Increase List Level clicked 4 x: Bold font in Orange (Route B&C) or Black
(Route A), e.g. for subheadings

1. Increase List Level clicked 5 x: Level 1 numbering
a. Increase List Level clicked 6 x: Level 2 numbering

- Increase List Level clicked 7 x: List with arrows, e.g. for conclusion

INCREASE LIST LEVEL CLICKED 8 X: BOLD, UPPER-CASE LETTERS,
E.G. FOR SHORT DIAGRAM CAPTIONS

Just try it!

valantic

No! Yes!

Ftevis:% View H%p Shapt
= — o= . 3= [t=.
— B — —_— =

] Paragraph
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POWERPOINT TIPS & TRICKS

Reusing slides

* Use the Reuse Slide function to load individual

slides from existing slide decks into your file. PN SR A L

* With this function, you can e.g. load ﬁj A TE’ @\ Layout ¥

H " " é._’j Reset
appropriate layouts from the “Layout Samples Paste New Reuse =
: : v Slide ~ Slides_ &5 Section v
file, our references or images from the Imagery CJ Section
Clipboard 5] Slides

files.

. | ® Aufzeichnen | | = |
- You should therefore save the three files — =

2 : w0 B £
A_Layout-Samples, B_Layout-Samples, - e | aer0r || D | hdd | D
C_Layout-Samples somewhere where you can e :

. . Folien wiederverwenden v ox
easily access them at any time! The same

« ‘ OneDrive, SharePoint und diesen PC durchsuch P A

ruer g

applies to the Company Presentation, st jedes

verwende

* Dukanns [ ]
- Funktion

= Datei ziet
o dir helfen, die integrierten

— Du musst .
- eintragen
"""" P vereinfacl o
- N e arbeitest. Du musst dann nur olie einfugen

Folie &

References and Imagery files. = = | -

template

- Speichere
@ A _Layout ib, den du jederzeit gut

C Layout
du jederz

template

R Py 1

o
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POWERPOINT TIPS & TRICKS

“Hiding” unused content boxes

If you are bothered by empty, unused content boxes in your slide, you can simply make them disappear, without having to delete them.

- Click with the mouse in the corresponding text box and press the <Space> key.

The lines are not visible in presentation mode, by the way.

ELICK T ADD TEX

Click to add title

CLICK & Space

/ CLICK & Space

Click icon to add picture

i

Click icon to add picture

o

Click icon to addﬂoﬁnﬁ
F

Click icon to add pic‘tV

!

Click to add text

Click to add text

Click to add text

Click to add text

YO RBD TEXT

Cllck to add title

R 2 A 2 A 2 RS B
B E e 2 E dl e 2 E ol e 2 E I
\
valantic valantic layout samples 2023
CLICK & Space
valantic

v

Click icon to add picture

Click icon to add picture

o o
Click to add text lick to add text
bq e B FalF e =2
E.Ic;‘-s- El D] E.Icc;-s- El D]

Click to add text

FHC—",\ 2=
BEIE

valantic

valantic layout samples 2023
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POWERPOINT TIPS & TRICKS

Reset slide

* If you use the in-built layouts systematically,
you can restore the original formatting with
one click

* To do this, click on “Reset” in the Home ribbon.

* If something has shifted or you were a little too
enthusiastic in changing your design, you can
clean it up with one click

* This works best if you systematically stick to the
layouts; it also provides for quick and easy final
quality assurance

* Be careful - If you've rearranged a lot, you may
not want to use this feature, as a full reset
could undo much of the originally desired
rearrangement

valantic

Insert Draw

Design  Tr:

Layout =

1[5

Mew | Reuse

@ Reset

Slide ~ | Slides | [ Section.~

Slides

| SURNAME NAME
i Pposition

| +4989200085910

SURNAME NAME

+49 89 2000 85 910
+49 89 200085 92 1

SURNAME NAME
Positior

+49 89200085910
+49892000 8593 1
info@muc.valanticcom

22

Ainmillerstraie 22
20801 Manchen

com

80801 Manchen
Deutschland

valantic

SURNAME NAME
Position

+49.89 2000 8591 0
+49.89 2000 85 93 1
info@muc.valantic.com
AinmillerstraBe 22

80801 Miinchen
Deutschland

Deutsehland

SURNAME NAME
Posit

+49 89 2000 85910
+49 89 2000 85 93 1

Deutschiand

SURNAME NAME
Positio

+49.89 2000 85910
+49 .89 200085 93 1
info@muc.valantic.com
AinmillerstraBe 22

80801 Miinchen
Deutschland
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POWERPOINT TIPS & TRICKS

The valantic Gradient

We have set the so-called design colors in PowerPoint to colors that do not
have a signal effect

Nevertheless, the valantic Gradient — our Orange color Gradient — is firmly
anchored in all Routes

To enable you to access the Gradient easily, we have defined it as the default
for new shapes. There you can apply the Gradient using the function “Paste
Format” (brush icon) wherever you want. Here's how it's done:

— click & drag a rectangle (Home — Insert — Rectangle) and select it
— copy the Gradient via Home — Clipboard — Paste Format (brush icon)

— click on the element you wish to color with the Gradient. Et voila

To completely remove the Gradient:

— We have saved the two colors valantic Coral Red and valantic Peach under
Custom colors.

— The Gradient transitions from Coral Red to Peach — at an angle of 315°.

valantic

& AutoSave li'i

File Home
&
Ik
&

Clipboard [

Paste

"

| &2 Foiteffeket - | 2 Suche
Designfarben z

e
i 1
-l-"“lll

Benutzerdefinierte Farben

Standardfarben
] | EEEEN

Keine Fiillung

éii Weitere Fillfarben...

f Pipette
B Bild... L
|] Farbverlauf >f
l i
at Strulctur > ¥
]

D O &

~ Fillung

) Keine Fiillung

O Einfarbige Eollung

(] Farbverlauf

) Bild- oder Texturfiillung
) Musterfiillung

O Folienhintergrundfillung

¢

Voreingestellte Farbverldufe ‘ D

<

Typ | Linear

=

4

Richtung

Winkel | 315

Farbverlaufstopps

[— (3| 3]

Farbe ‘ 2 e

Position | 0% |

Transparenz ——— | 0% o

Helligkeit ~——+— [ 0% |
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The Format Painter brush

* The Format Painter brush is an easy way apply the format of one object to
another

* Click the object with the desired format
* Then click the Format Painter brush
* Now click on the object you wish to reformat

* The formatting is applied to the object

- If you click the Format Painter brush once, the format will be applied to one
other object.

- If you double-click on the Format Painter brush, you can apply the
formatting to as many objects as you like! To terminate this function press
e.g. <Esc> key.

valantic

ﬂr AutoSave '::'!

File Home

&
O

Paste

e

Clipboard

M
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POWERPOINT TIPS & TRICKS

Applying the Gradient to icons
@ AutoSave (@ 0

. . Fil H In:
* In general, the Gradient does do not need to be applied when small-format e eme

icons are used NN @ (])E’ﬂ

\ 4

* Small icons are colored Coral Red (= Shape Fill - Custom) but can also be Change | Convert
Graphic v to Shape

colored Dark Blue, Royal Blue or Violet depending on the Route you use

Change
* If you want the icon in valantic Orange to be particularly eye-catching, however,
it would be great if you use the Gradient for it!
‘ ] O @
Here's how it's done: v
w Fr‘"g
* Convert the icon into a Shape (mark icon — Graphics Format — Convert to O Keine Fullung
() Einfarbige Fiillung
Shape) O Farbyerlauf
() Bild- oder Texturfiillung
* Then assign the Gradient (= “Lifehack: the valantic Gradient”) - E“f:-!ggdf”g
Voreingestellte Farbverliufe | |] h |
Typ | Linear - |
Richtung | D ‘|
Winkel EEN
Farbverlaufstopps
— (| 3|
Farbe | 2 > |
Pasition | 0%

Transparenz ——— [ 0%

Helligkeit ——+— | 0%

o
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Insert footer

If you would like to add a footer to your file, you don’t have to set it manually on e

h Id Insert |Draw  Design  Transitions  Animations  Slide Show Record Review View Help  Picture Format

H N, & @ 24 4 68 Be R © =)

. . . . . . Table Photo SmartArt  Chart Power Forms Zoom  Link Action Comment Header
You can add the footer to your file quickly, with just a few clicks — best done in the - Album - B S Foater
Tables Image_s Camera lllustrations Power B Forms Links Comments Te

last step. * ” I
|
Here's how it's done:

* Insert > Header & Footer | e

:5”‘15 Motes and Handouts

* Choose and enter the details you need B Pren

© Update automatically

¢ Choose "Apply” or "Apply to All”

4-5ep-23
LEannggl\us:\g[t.;nitedStates] - 5;::::;:”5
* This way, you can also remove footers or move them back to the right position O

@ slide number
@ Footer
valantic layout samples 2023

@ Don't show on title slide

Apply Apply to All Cancel

d l

Charts

valantic layout samples 2023
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POWERPOINT TIPS & TRICKS

Comperessing images to reduce the file size

Sometimes files become very large, for example when they contain images.

If you want to send such a file, you may wish to compress all the contained
images beforehand in a single step:

15 Animations  Slide Show  Record  Review

View  Hel Picture Format

Picture Styles

¢ Select an image
* Go to "Compress Images” under Format
* Choose your appropriate settings
Ager
%

Please note that image information is lost in compressed images. You may
therefore want to save the file with the compressed images as a separate
copy.

Titlepage
Divider

Agenda

Layouts

Compress Pictures

Compression options:
[ fpply oniy to fhis picture;
Delete cropped areas of pictures

Resolution:
High fidelity: preserves quality of the ariginal pici
HD (330 ppil: good quality far high-definition (HD}

Print (220 ppil
© Web (150 ppil: good for web pages and projectors
() E-mail (96 ppi}: minimize document size for sharing
() Use default resolution

Contents
Charts

Basics

valantic

valantic

excellent quality on most printers and screens

| @ Record | | & Present in Teams | \E\
o 4
ol B E A T

Selection  Align
Pane

O

Rotate

Accessibility

Arrange

Size

d

Cancel

valantic layout s2
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POWERPOINT TIPS & TRICKS

Using tabs to insert times into the agenda

* You can indent with tabs using <CTRL> + <Tab (=|)>.

* This lets you e.g. insert times elegantly in our Agenda layout

My perfect Day

08:00 | Home | waking up

08:20 | Café Orange | having breakfast

09:30 | Cologne | taking the bike to the office

10:00 | Teams Session | creating cool PowerPoint slides with my colleagues

14:30 | Celentano | having a coffee with my work mates

valantic

CTRL + TAB

My perfect Day

08:00
08:20
09:30
10:00
14:30

Home

Cafée Orange
Cologne
Teams Session

Celentano

waking up

having breakfast

taking the bike to the office

creating cool PowerPoint slides with my colleagues

having a coffee with my work mates
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Enjoy your new
PowerPoint Layouts

HEIKE HUNSMANN

HEIKE BERGER SYLVIA SKARBEK

Brand Manager PowerPoint Specialist Brand Designer
valantic wdp valantic

heike.hunsmann@muc.valantic.com
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